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STATIC ANALYSIS OF A SPRING SYSTEM
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Figure 1

Determine the displacements at nodes of the spring system shown in Figurel

PROCEDURE
STEP

1. Create four points at (0, 1, 0), (0, -1, 0), (2, 0, 0) and (4, 0, 0)

Commands . POINT, ADD
Menu . Geometry 2 Key point = Create 2 By X/Y/Z
Parameters : (To be filled by the user)

Coordinate Data 0/0/0

Coordinate Type 0

Entity ID

Similarly create the other points.

Note:

Click "Apply" button or press cntri+enter key after completing each step. "Done" message appears on
message box for every step executed successfully.
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At the end of the above operations, your screen should look like this

lJJ Eile Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help

'“n}.ﬂ&%lﬁ‘-ﬂﬂﬁ-@tl

_I Maml Edit ShOWI Colourl Settlngsl
I Free Edge

Zfir o PreWin 2017R2
|_| I Node VSSC/ISRO

™ Element o1

I Curve
¥ Paint '3 '4

™ Plane

Al

Click here for
labelling
entities

Opened \110.45.28.45\d\SDCS\ lyothi\ FEM\SPRING - Copy.prj

Command:

[l | Ready:. Processing for display...

2. Create nodes

Commands : NODE, SNAP
Menu . Mesh - Node - Create > Snap
Parameters

Point Data P1

Entity ID 1

Similarly create the other nodes.
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At the end of the operation/s your screen should look like this.

) PreWin 2017R2 (PROFES!

[||| Ele Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help

@ mma®m o -

l

ooy yE -leaD «soi|Bal &5

Main! Edit SI"10W| Col ouri Settings!

[~ Free Edge
™ Grid

4 ¥

PreWin 2017R2

W Node
I~ Element
[~ Volume
[ Surface
™ Curve
W Point
[~ Plane
LS

V¥8SC [ISRO
ol

ic|e] [ A

NODE,SMNAP

Paint Data |P4

(| ||s (2] |0 B x|@ 98N]

EntitylD |
Command: NODE,SNAP &
Nede 5 is merged with Node 4 !
MNODE,SNAP - Done ! ﬁ

h |1_ AutoExec » -
| Ready. Select: Vertices
3.  Create spring elements

Commands SPRINGELEM, ADD

Menu Mesh - Element - Create - Spring = Add

Parameters

Node Set 1 172
Node Set 2

Spring Constant | 30000
LCSID 0
Output ID 1
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At the end of the operation/s your screen should look like this.

” File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help

E -‘*4‘! i

ro

oA & s @M am o
Bo@dUlvyE oe|e O e -0 EM @5

LL

Main Editl Shuwl Colou!l Seﬁingsl D
Itern - Sets %
DispConstraint PreWin 2017R2
Force VSSC/ISRO

StaticGen

SPRINGELEM,ADD L ¥
MNode setd | A IES

Spring constant iEOOOU g

LSS fo B ELEMENT, DELETE - Done !
Output | —| | Command: SPRINGELEM ADD

SPRINGELEM,ADD - Done !

L8 ||o[2]S[O ||8[x|@ [|9@]]|-

il < [

f ||_ g :—II- Command:
|Read‘y. /
Similarly create the other two spring elements.
JJ File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help
o8& & @R o o
| Bo@U vE == |oao|n wig[Ba @50
E Main Ed'ftlshuwl Cofouri Sett'mgs! @
Ttem Sets
N | rpcamsin PreWin 2017R2
| Force VSSC /ISRO
EI StaticGen
K
=
] E
(&)
ﬁi v
L
SPRIMNGELEM,ADD
B a
—| Nodesett |21 1
ﬁ! Node set2 | _QJ
E’ Spring constant |50000 Eli— SPRINGELEM,ADD - Done ! =]
= Ii = SPRINGELEM.ADD - Done !
el Lol C by I SPRINGELEM,ADD - Done ! zl
_BE! ||_ AutoExec Apply
- —— | Command:
|Ready. o
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4. Specify displacement boundary conditions
Commands BC,ADD
Menu Load/BC - Displacement BC - Add
Parameters
Elec =1
Node IDs | 1/3 Transation Apoly
BC Value | 1/0/2/0/3/0/4/0/5/0/6/0 oo [
LCSID |0 Eﬁ* e
Frefo
FRyfo
Frfo

At the end of the operation/s your screen should look like this.

|] File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help

NodeDs [1/3

BC value [1/0/2/0/3/0/4/0/5/0/6/0

=18 |~

. =

o é& & Mmoo~
[Bo@mulvyE| ow e 0| n == 35| E f P
j @I_E{ﬁii Showl ColouriSeﬂ:ingsl :j
: [> Add -

< b PreWin 2017R2
= E o VSSC /ISRO
_';l .rase

— [> Find =
LIy

.j - ®[0 Heat Transfer BC
1.Eﬂ| i pifl Bruk besd ~|

&

O

fd BC,ADD y

L)

i

‘_g_l

)

11!

5]

Lel

I teso o
setd |
BC,DELETE - Done !
Command: BC,ADD
BC,ADD - Done !
|r' AutoExec Appl " 3
_ ommand:
| Ready.
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5. Specify point load

Command : FORCE, ADD
Menu :  Load/BC - Point Load = Add
Parameters
Node IDs 2
Data 45
Component Fx
LCSID 0
Set ID

Similarly create the other load at node 4

At the end of the operation/s your screen should look like this.

4 Prewin 2017R2 (PROFESSIONAL VerSION) -
||| File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help
EEL IR
BroO G| vE|m |0 O i FEa &%

| Main] ecit| Show| Cotour] settings| C%@

FORCEADD - Done!

‘T‘ AuvtoExec P
Comrnand:

| Rea&y.

;] 5] Heat Transfer BC _:j
« = ;
< - g Prewin 2017R2
=] : E i VSSCISRO
i

~:]; [> Delete ] .\~
&= . [> Show \‘\“\
= - [» Erase \'\\‘
A°_J ~[» Find -\\\
ﬂ: D> Size | e
|
Lel|
ﬁ] FORCE,ADD

| ikt oot v
a|| Neders &
.E_] Data ]_3,0—‘ El_i X
~ | Component Fx—
f".J- o o k]
Jﬂ' SetID — Command: FORCE,ADD
1‘ FORCEADD - Done!
|
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6. Set the analysis type

Command : ANTYPE, SET
Menu : Analysis = Analysis Type
Parameters

Analysis Type Static

7.  Set the analysis options

Command : ANOPTION, SET

Menu : Analysis = Analysis Options

Parameters -
Linear Solver Multi Frontal

8. Save the project model
Menu : File > Save
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Submit the job into FEAST

Menu  : Analysis 2Run solver

PreWin 2017R2 (PROF

J| File Edit View Geometry Mesh Load/BC  Propertty Analysis  Settings Post  Help

Y= -

Command: STATGEN, ADD

||— AutoExec Apply I
Command:

| Ready, Message box |

— 1= A
ij ~[» RunSolver ;
B Static PreWin 2017R2
| (E R 1 Ganssal VSSC/ISRO
el > Add
___ ] - [» Delete =
EI - #(] Tnertia Relief
;l 5__! Free Vibration
# _| Buckling =
B——— - »
£l
(¢]
il STATGEN,ADD | i
ﬂl Stress output Yes — 1
Ll Lx
-
= Command: POST, VIEWRESULTS j
2|

Note:

"Finished successfully" message appears on message box after executing is completed.

10. Perform post processing

i) Deformed shape

Command POST, DISPDEFORM
Menu : Post = Deformed shape
Parameters

Scale factor 1
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At the end of the operation/s your screen should look like this.

| File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help

oA s s ERO % o
Bom vE - eho sl Ea @&

(| Mein|Edit| show| Cotour] settings] &
[> Deformed Shape :‘ ;
[ Contour PreWin 2017R2
-l B s VSSC [ISRO

[> SectionContour
-~ [» PathPlot

- [> History Plot

~ [» Shock Response
[ Vector

I View Recuibte = b

[» |

Displacement: Y

Scale Factor |—3

¥ Superimpose Lx
™ Highlight Maximum
™ Animate Deflection

DEFLECTION
Maximum Displacement = 0.00196364

=

ColourDeformed shape 1l . Cormrmand: POST VIEWRESULTS
4 I I v l:l Command: STATGEN,ADD
Command: POST, DISPDEFORM EI

Command:

ek sz Ok E[x|e BE[]]

-

eady. .
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Figure 1

Consider a planar truss loaded as shown in the Figure 1. Find the maximum displacement and
deformed shape of the truss.

Material property: E = 2./E+1] Pa, v= 0.3
Point load, P = -1000 N
Cross sectional area of AC and BC = 0.0002m’

Cross sectional area of CD and BD =0.0001n"

PROCEDURE
STEP

1. Create the points A, B, C and D at (0,0,0), (1,0,0), (0.5,0.5,0), (2,1,0)

respectively.
Commands . POINT, ADD
Menu . Geometry =2 Key point 2 Create > By X/Y/Z
Parameters : (To be filled by the user)
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Coordinate Data 0/0/0

Coordinate Type 0

Entity ID

Similarly create the other points.
Note:

Click "Apply" button or press cntri+enter key after completing each step. "Done" message appears on
message box for every step executed successfully.

At the end of the above operations, your screen should look like this

r@ PreWin 2017R2 (PROFESSIONAL VERSICN) - l = i =] é
File Edit ¥iew Geometry Mesh Load/BC Property Analysis Settings Post Help
O &S| RO W o
B oML vE - o e =il E& % !
Mﬂi"lEdit] Show] Colour] Settings} 0]
—J' I;I Commands i %‘;j
= &1
| =@ Geomeny PreWin 2017R2
m| O KeyPoint VSSC [ ISRO
=1L Create
el D ByXiv/z o
iJ [> OnPlane
|| > BN
_‘:_J + (1 On Geometry
#[Z1 Copy 4 3
Click E-J ] Move
# (] Miscellaneous
here for A w o
labelling Ol #0 sufece
" ﬂ #1 Volume al o2
entities ] Plane hd hi
|
&) *
N—
|
l POINT,ADD
H 2 | POINT,ADD - Dane | =
Coordinate data |2/1/0 i
';IIJ .j‘ POINT,ADD Dunei j
| e POINT,ADD - Done! -
v
ﬂ it —J Command:
Ready.

Geometry = Curve - Create 2 Line

Use Mouse to pick the points 1 & 3

2.  Create lines AC, BC, CD and BD.
Commands CURVE, LINE
Menu
Parameters End points

Entity ID

1
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This will create the line AC.

” File Edit View Geometry Mesh Load/BC Property Analysis  Settings Post Help
HE: D e=nEBa @
_II MamlEd;{! Shuwl Co[ourl Settmgsl @
{|C3 Commands )
il | [E=i |
<] G Gl Prewin 2017R2
m| | 26 KeyPaint VSSC/ISRO
= Curve
;l |_ID Create A
B - [» Line
- [> Circle

_I [» Circle3p [+
EI [ Arcep k]
=l [ Arc3P
;X:J [» Spline

i Ellipse

~ [» Ellips
Q] - #E3 on Geometry 2
_ﬂ - @[] Using Points J

#C Coin h Y
L)
E_l ""'CI'-"‘p | al & X
]

CURVE,LINE
=l Zi | command: curve Lne |
= End Points [PL/P3 BJ CURVE,LINE - Done !
= CURVE LINE - Done ! j

ﬁ Comrmand:
| Ready. Select: Point

s-‘A‘ i

ro

Similarly create the lines BC, CD and BD. At the end of the above operations, your screen

should look like this.

Property  Analysis  Settings

Post Help

'D@’?U\JE|E¢+|I%

O w e A &5

Maif HI Edlt’ Sh owI G olour! Settmgsl

l_—_

3 Commands
-;H:I Geometry
@[3 Key Point
- = Cunve

a

=0 Create

[> Line

[> Circle

[> Circle3p

D Arc2p

[ Arc3p

- [» Spline

- [» Ellipse
=] On Geometry
(1 Using Points
w0 Conu

CURVE,LINE

End Points |F'ZI’P4 |'—I
e

I% so)s ||g|2s O B8 IIE*_IEIA

PreWin 2017R2
VSSCI/ISRO

—

CURVELINE - Done!
CURVE,LINE - Done!
CURVE,LINE - Done !

Command:

Lel

=

3

£
2

Select: Point A
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3. Meshing using beam elements

For creating rod elements first meshing is done using beam elements and then modified as rod

elements.
Commands FEM, BAR
Menu Mesh = FE Mesh - Bar
Parameters
Curve 1T4
Element Size 5
Type 2-node
Subdivisions 1
Bias 1.0
Note:

Right click/left click mouse point to alter sub-divisions.

BreWin 2017R2 I

| Eile Edit View Geometry Mesh Load/BC  Property Analysis Settings Post Help

|oZema #RaH - -

POV yE| Ew|oaD = =uEA 850

Shs

Main| dit] Show| Colour| ettings|
I__] Commands 2]
#[ Geometry
=10 Mesh
= FEMesh Bl
[> BAR
[> QUAD
[> TRIA
[> HEXA -
FEM,BAR
Curve T4 ‘_k_j
ElemSize |5 _M
Type _2-Node — |
Subdivisions ﬁ— ‘B_J
Bias 1 _%_]

&

PreWin 2017R2
VSSC[ISRO

big

I

oo |#[2s O Bl<|a 9o

_-Raa d)r

v AutoBxec APF

FEM,BAR - Done !
FEM,BAR - Done !
FEM.BAR - Done !

Command:

Ll

Select: Curves -
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4. Convert beam elements into rod elements
Commands ELEMENT, TYPE
Menu Mesh = Element—> Modify—=>Type
Parameters
Element IDs All
Element Type Rod

[/ File Edit View Geometry Mesh Load/BC Property Analysis  Settings

IR R

Post  Help

(B LPOU s E T v oD e E e
| [} Mai] i snow| colour] setting| g
#EA Create i] é%;
Bl Moddy PreWin 2017R2
[> Convert J VSSC /ISRO
[> Degenerate
[> Break
[> Subdivide
[> Attributes
> Type -
ELEMENT, TYPE

Element IDs ]AH

Element Type Rod 4 v

L.

RODPROP,ADD - Done !
Command: ELEMENT, TYPE
ELEMENT, TYPE - Done !

7 -

||7 AutoExec
Command:

B g (= (o |» lo)z]s o= @@ |9

=
m
1
o

=

LR

5.  Merge duplicate nodes.
Commands NODE, MERGE
Menu Mesh = Node—> Modify>Merge
Parameters
Element IDs All
Tolerance 0.0001

95



FEASTSMT

/ PreWin 2017R2 (PROFE

‘_l File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help

~f..
=il |i5To

o3& @R o -
oo sy E|mea e aD| e A 8L

3 Main Edi’tlshcvwi Coluurl Settmgsl 4@

= ~Item | [ Setz

—I DispConstraint PreWin 2017R2

&1|| | Rod property VSSC /ISRO

El Force

— Material

% ‘ e Edit Delete

| o|e|ol@| @ E ] +

N an|D|M| P| T| I |nc|G| x|~

g NODE MERGE |

ﬂ Node IDs |m _Di! v

ﬂ Telerance !U‘UUUI
'E_l L"
| 4|

=l Command: SET, NORMALVIEW Al

,_1] Command: POST,DISPDEFORM

= Command: NODE,MERGE j

EE’ ¥ AutoExec Apply Command:

|Ready. Select: Nodes o
Erase Curve (Optional)

Commands CURVE,ERASE

Menu Geometry > Curve = Miscellaneous = Erase

Parameters

CURVE,ERASE |
Curve IDs |1 ks ||
Note:

Likewise erase key points by POINT,ERASE,ALL command.

Specify displacement boundary conditions

Commands BC,ADD
Menu Load/BC - Displacement BC - Add
Parameters
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- Elec =]

Node IDs | Select the node at the points A S —

and B AT Cancel
¥ Uy ]?,—'
BC Value | 1/0/2/0/3/0/4/0/5/0/6/0 E'l Pl
LCSID 0 o=
™ Ry ]T
Frfo

At the end of the operation/s your screen should look like this.

{45 PreWin 2017R2 (PROFESSIONAL VERSION] - Untitied

0P AS[ERO N o

File Edit View Geometry Mesh Load/BC Property Analysis Settings Post  Help

BooU sE| s ean|smu(BEal o2
[ il stow] o] stingl &
[> Add -]
P .
sl I el PreWin 2017R2
=l E Delete J VSSC/ISRO
Erase
L] [» Find
‘&-EJ [ Show
[> Size
j | @[ Heat Transfer BC ~|
H
k1
g BC,ADD
el Node s [1/5 ey
L.l BCvalue [102703/0/40/50/60 B3| v
E LCS D 10 _R.‘.J
_‘!tj SetID X
111 ELEMENT, TYPE - Done | =
B_Iﬂj Command: BC,ADD j
BCADD - Done! -
]FJAutUB(ec ‘J Command:
:REEd-_;fH )

Specify material properties
Command
Menu

Parameters

MATERIAL, ISO
Property = Material = Isotropic 2 Add

Element IDs All
Material Data | 2.1E+11/0.3/0/7850/0
Material ID 1
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9.

Specify Rod Properties

Command

Menu

Parameters

At the end of the operation/s your screen should look like this.

RODPROP, ADD
Property = Physical = Rod Properties > Add

Element IDs

1/2

Area of cross section

0.0002

Torsional Constant

Set ID

-]
alf
A
_°J
EJ.
3
<l
2|
A
|
"
|
B
|

FEEDETELICE

File Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help

Rea dy

PoOG yE = oo =« Eas @
Maini Edlt] Shcfw] Cotourl Seﬁmg;q 55!?
=3 Material :J %gg
- =l Physical 7
; BN b PreWin 2017R2
# [ Thickness VSSC 1 ISRO
] Beam properties
=11 Rod Property =
[» Add
[> Edit
[> Delete _:J
RODPROP,ADD
Element IDs 12
Area of cross section |0.0002 ¥
Torsional constant
SetID X
MATERIALISC - Done !
‘i 1 = Command: RODPROP,ADD
RODPROP,ADD - Done !
I]V AutoExec
——1 | Command:

similarly specify the rod properties for elements 3 and 4
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5 i 25175 PROFESSONALVERGON

!_Eile Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help
EEr L

SOoOL| vE oD eeEE&S 05
ME""lEditl Shuw] Culouri Settings | (o

B! + D i\dater‘\a‘l _:j @

'—"I;ICPIhySi(_Bl PreWin 2017R2
+ Thickness J VSS8C/ISRO

1 Beam properties

=11 Rod Property

[> Add

[> Edit

[ Delete -

RODPROP,ADD

Element IDs 374

Area of cross section |0.0001 ¥
Torsicnal constant
SetID X

Command: RODPROP,ADD =
RODPROP,ADD - Done |
RODPROP,ADD - Done |

4 »

kel

mElzlels [s3s ol Blxle @]

‘W AutoExec
——1 | Command:

.. REad‘y.

10. Specify point load
Command : FORCE, ADD
Menu . Load/BC = Point Load = Add

Parameters

Node IDs 8
Data -1000
Component Fy
LCS ID 0

Set ID 1

At the end of the operation/s your screen should look like this.
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(355 preWin 2017R2 (PROFESSIONAL VERSION
o4

File Edit Miew Geometry Mesh Load/BC Property Analysic  Settings  Post  Help
=L e
[Boo G yEB ool s @a O 5
| Mﬂif'l1 Edit] Show] Culouri Settings} C)
J‘ #(0 HeatTransferBC 4| c%;
2 =0 pointoas PreWin 2017R2
=] E ’;‘:: VSSC I ISRO
_L] [> Delete =
= [> Show
El‘ D Erase
_°j [> Find _._]
]
3|
g‘ FORCE,ADD
ﬁ]‘ NodeIDs |8 _%_j
ﬁl‘ Data -1000 = v
E] Component Fy ~
ﬁl‘ LcsID 0 I X
E.]‘ SetID
lT]‘ Command: FORCE ADD
_;f] FORCEADD - Done !
FORCE,ADD - Done !
¥ AutoExec G
:Edwt‘\uad;, BCs and properties .

Lel

11. Set the analysis type

Command : ANTYPE, SET
Menu : Analysis = Analysis Type
Parameters

Analysis Type Static

12. Set the analysis options

Command : ANOPTION, SET

Menu : Analysis = Analysis Options

Parameters -
Linear Solver Multi Frontal

13. Save the project model
Menu : File > Save
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14. Submit the job into FEAST

Menu  : Analysis 2Run solver

TG

H File Edit Wiew Geometry Mesh Load/BC Property Analysis Settings Post Help
o3& 8 #@MRE N - |
Foomy yE e e 0w =it Ea o9
=
;l Main| Edit| Show Colour] settings| ég;;
] Node m -
Labels Elérrient n PreWin 2017R2
||| Background VSSC/ISRO
) Volume !
E] Paint Mode
—| | Shading et L]
E Colour List Curve !I
_i] Point | |
Plane !l
B Lcs n
}J DispConstraint [l
Pressure !|
-Q] Force || 5|
2| -
B\ackl Whlte! Custnrnl Load.. | Store.. l Y
L]
2l g
| 2|
STATGEM.ADD
EI . Writing Results... 5= |
,_1| e ELAPSEDTIME :0H:0M:=05 £
= inished successfully =
¥ AutoEx A
ii | e —-F-Ety-—- Command:
|Ready‘ |

v
Message box

Note:

"Finished successfully" message appears on message box after executing is completed.

15. Perform post processing

i) Deformed shape

Command : POST, DISPDEFORM
Menu : Post = Deformed shape
Parameters

Scale factor 1

At the end of the operation/s your screen should look like this.

101



+-

FEAST VT Fwil |is7E
5 i 701785 RN =
|| Eile Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help
oFEes tRad% < - |[Ho00 yE| cwoaD v onfE;m @ 5 &
Ll Main Edit| Show| Colour| Settings| FP
Item Sets &
ksl DispConstraint PreWin 2017R2
||| Rodprapery VSSC/ISRO
_':J Force
Material
| = —— 000627504
= | Edit | Delete| !
H
&
Ol Gipcemen
ﬁ.l Scale Factor 1
ﬁ] ¥ Superimpose
El’ ¥ Highlight Maximum
| T Animate Deflection
|£J Colour:Deformed shape [l
|_EI Colourlegend [
i
[ Y
=
LX
I T DEFLECTION
= Maximum Displacement = 0.000627904
Command: POST,BEAMFORCE S
POST, BEAMFORCE - Done !
Command: POST, DISPDEFORM =
|I7 AutoExec
Command:
| Ready. 5
ii) Beam force

a. Shear force diagram

Command
Menu

Parameters

: POST, BEAMFORCE
: Post > Beam Plots > Force Diagram

Component

SHEAR 1

Plane

Plane-1

Decimal Places

2

Scale Factor

1

No. of contours

9

At the end of the operation/s your screen should look like this.
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FE AS.I.SMT =il |isFE
3 PreWin 2017R2 =
|| Elle Edit View Geometry Mesh Load/BC Property Analysis Settings Post Help
jloBA&as RE% < ~ (Booy yE o lokD «wil|Em @8- &
Zi Main Edit| Show| Colour| Settings|
Ttem [ Sets 1.74E+03
e
= DispConstraint PreWin 2017R2 1.16E+03
51|| | Rod Property VSSC {ISRQ
El Force 5.80E+02
= Material
— 3.66E.04
|E‘ ——— | Edit Delete.
x| 5.80E+02
1.16E+03
& -1.74E+03
_Q' POST,BEAMFORCE SRR
ﬂ Component | AXIAL -
-2 90E+03
ﬁl Plane Plane-1 ]
| Decimal Places 23 3.48E+03
| scaleFactor 1
| -
No. of contours 9:1
S
|2 Colourlabel [
LTI e
e
— i
=
x| *
= BEAM FORCE (AXIAL)
Minimum = -3479.03 Maximum = 1739.51
Command: POST,DISPDEFORM ﬁ
Command: POST,BEAMFORCE
POST,BEAMFORCE - Done! Ei
v AutoBxec Apply
......... || —

|Ready.

plotting...

b. * DAT file shows the input data and *.OUT file shows the output file.
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